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OVERVIEW

Thank you for purchasing Art Appeal.   We are dedicated to providing you
with the highest quality and most creative business art available.  Our 1,200-plus
images put you in the artistic driver's seat, allowing you to create imaginative,
effective documents and presentations.  After creating a sparkling report  or a
winning presentation, sit back and enjoy the praise.  You don't even have to tell
anyone we helped. 

While our 1,200 images are designed to give you unequalled variety, they
may become difficult to keep track of.  Art Appeal comes with a utility we have
provided named The Browser.

The Browser  needs some further  explanation and as such,  we've put
together this on-line user's manual to help things along.  This manual can also be
printed.   For  reading ease,  we've  used a  fairly  large font  and generous line
spacing.  While these features make the manual easy to read on the screen,
expect about 35 pages of output when you print.

So what's this Browser all about?  The Browser is designed to manage a
collection of graphic images in the Microsoft Windows environment so that they
may be readily retrieved when desired.  The program reads a variety of different
graphics programs in addition to the Computer Graphics Metafile (CGM) format
of this product.  Please see Appendix I at the end of this manual for a complete
listing of those formats.

In  designing  our  manual,  we  assumed  that  you  are  familiar  with  the
Windows operating system, with the use of a mouse, and with the terminology
used to describe both.  For more information, please refer to your respective
Windows and Mouse manuals.

The Browser is based on the "Catalog" concept, which can be likened to
a file index.  A catalog is a group of images defined by selected criteria.  For



example, if you're working on a project which utilizes 20 different images, you
can create a "custom" catalog for  those images.   Your  new "project"  catalog
allows you to  quickly  find the 20 images.   Other  catalogs can be developed
based on  usage, size, color, resolution, graphics format, subject, content, etc.

Catalogs are created via the Create Catalog option.  Images are placed in
the catalogs via the Build Catalog option.  The catalog entries can be annotated
with your own comments by supplying keywords and/or a description.  After data
has been entered relating to the images, searches can be made throughout the
entire collection of images based on selected search criteria.  In other words,
The Browser functions as an image database.

Art Appeal comes with pre-built catalogs.  Each category contained on the
CD-ROM,  both  in  CGM  color  or  WMF  color,  has  a  corresponding  pre-built
catalogs with keywords for that category.
  

Another useful feature of The Browser is the On-Line Help feature.   Help
is available to you in any screen by clicking on Help in the Menu bar or clicking
on Help in the dialog box currently on the screen.



Please keep in mind that  The Browser  is a utility to organize and view
your  images.   One  feature  of  The  Browser allows  you  to  view  images  as
"thumbnails" (small versions of the individual image).  Thus you can see exactly
what is going into your "custom" catalog.  Note that the thumbnail image viewed
is not the same quality as the actual Art Appeal image located on your CD ROM
(or in your hard drive if you had the room to install them).  The thumbnail view is
a "jaggy bitmap" image, while the actual image is a high quality vector drawing.
In this case, what you see is not what you get!  You actually get better!   

The entire MCP staff is dedicated to you, the user.  If you have a question
or something isn't  working just right,  give us a shout.   Customer Support is
available by calling 1-900-CALL CLIP.  This is a pay-by-the-minute service that
costs $2.00 for each minute.  The service is available from 9:30 am until 5:00
PM, Eastern time, Monday through Friday.  To use this service you must be 18
years  or  older,  or  have  the  premission  of  your  parents.   In  the  event  you
experience  a  problem  with  this  service,  please  call  (305)  967-8233  for
assistance. Again, thanks for investing in our product. 

GETTING STARTED

In general,  novice users will  find that  the  GETTING STARTED section
provides sufficient guidance for successfully using our product.  The  MAKING
THE MOST OF THE BROWSER section gets into more detail.  This section is
designed for advanced users.  The APPENDICES are more technical in nature.
They are provided primarily for reference.      



KNOW THY MENUS
The Browser consists of six main menu choices:

File
Catalog
Options
Capture
Windows
Help

Most user activity will  occur in the  Catalog and  Options  menus.  The on-line
user manual is thus set up to concentrate on these two main menu choices and
their underlying menus and options.  

VIEWING IMAGES
The easiest way to familiarize yourself with The Browser is to access one

of Art Appeal's pre-built catalogs.  This will give you the opportunity to learn the
basic commands as well as expose you to a grouping of images.

Accessing a Catalog to View
In order to bring images up on the screen, you have to access a catalog

from which to select an image.

USER NOTE:  If you didn't install the pre-built catalogs when you originally
installed Art Appeal, you may want to reinstall the program and elect to install the
pre-built catalogs.



If your pre-built catalogs are currently installed, proceed as follows:

    1.  While viewing the initial screen,  choose Select Catalog from the 
Catalog Menu.  The  Default catalog will be in the  Catalog

Title Window.  Scroll  down the choices and choose one of the
pre-built catalogs, such as Office, which will then appear in the
title window.  Click on OK.  Office becomes the current catalog. 

2. Select  Thumbnail  View from the Catalog Menu options.   The  
thumbnails  are  displayed  on  the  screen,  in  alphabetical

order, which is The Browser command default.  
 

Viewing the Image
It  is  important  to  realize  that  the  thumbnail  view  of  an  image  is  a

compressed view.  Thus, it doesn't reflect the true quality of the image.  To view
an actual image from a catalog, perform the following steps:  

1. Place the cursor on the image.  The cursor becomes a magnifying 
glass.

 
2. Double click on the left mouse button.  The actual image appears 

on the screen.  This process may take a few seconds.  
   

3. To view the image full screen (without any Windows' applications), 
double click with the left mouse button.          

4. Double click again to return to the Browser.  The actual image  
reappears with the Windows' application. 

 5. To  close  and  return  to  Thumbnail  View,  access  the  Windows  
drop-down  menu  (click  on  the  (-)  located  in  the  top  left

corner of  the image).  Select Close from the menu.  



Thumbnail Pop-Up Menu
The Thumbnail View screen permits you to do a variety of things through

its  Pop-Up Menu.  To access the Pop-Up Menu, place the cursor on an image
and click once on the right mouse button.  The Pop-Up Menu appears.  
    Information Option

Click on Information to view all data associated with   
the image.
1. The  View Catalog Entry screen appears  with  a picture  of  the  

image and a table of information about the image.  You can 
change the entries in the fields, as you desire.  See

the Section entitled CREATING A CATALOG for instructions.  

    2. In the View Catalog Entry, you can also choose to uncatalog the 
image  by  clicking  on  Uncatalog.   The  Verify  Uncatalog

screen appears to ask if  you want to uncatalog the image.
Click on Yes if you do or No if you do not.

    3. Exit the View Catalog Entry screen by clicking on Update if you 
have made changes to the data or Cancel if  you want to

continue with the current data in place.   The Thumbnail View
Screen reappears.

 Hide Thumbnail
There may be instances when you are working in a catalog  which 
has so many images that you want to hide some from view to make

your work more manageable.

1. Place the cursor on an image and click on the right mouse button 
to access the Pop-Up Menu.

2. In the  Pop-Up Menu,  click on  Hide Thumbnail.   The  Confirm  
Action! screen  appears  to  ask  if  you  want  to  delete  the



thumbnail from the  view.   Click  on  OK.   That  image  will  be
replaced by the next image in the category, if there are more
images, or it will be blank.
 

3. To view that image while it is hidden, go to Catalog on the menu 
bar and click on Display Hidden.  

4. To unhide the image, make sure Display Hidden is checked (step 
3).  Place the cursor on the image and access the Pop-Up

Menu.  Deselect the Hide Thumbnail option.
 

View Option
We told you there was more than one way to view an image.

 
1. Place the cursor on an image and click on the right mouse button 

to access the Pop-Up Menu.

2. In the Pop-Up Menu, click on View.  In a few seconds, the image 
will be displayed. 

Other features available in the  Pop-Up Menu are Launch Application
and Slide Show.  For  information on Launch Application, please refer to the
section entitled MAXIMIZING THE FEATURES OF WINDOWS.  For  information
on Slide Show, please refer to the section with that title.



BROWSING/SEARCHING THROUGH A CATALOG
The Browse and Search features permit you to look for an image based

on your desired criteria, such as keyword, format, date, or file size.  You can view
the image singularly or you can view a group of images which meet your criteria.
If  you  wish  to  have  smaller  catalogs  which  are  easier  to  manage,  you  can
remove an image or group of images from a catalog or from the hard drive itself.
This is an important distinction!

Initiating a Browse or Search
Before initiating a Browse or a Search, you must access a catalog.  Only

one catalog can be searched at a time.
1. Select a catalog from the Catalog Menu by clicking on Select 

Catalog.  Use the Up and Down arrow to view the catalogs on file.

2. Click on OK.  

3. Select  Browse from the  Catalog Menu.   The  Browse/Search 
dialog menu appears.  

4. Click on Options >> in the Browse/Search dialog menu.   Enter 
your criteria -  format,  special conditions and/or  search  

keywords.   For  more  technical  information  of  the
search process, see Appendix II, THE SEARCH OPERATION.

5. Click on  Search.  The  filenames from the current catalog which  
meet your defined criteria appear.



Viewing Images
It is much more useful to view the images themselves than to simply look

at the filenames.   In the Browse/Search Menu perform the following steps:  

1. To view the images on the screen, select a filename and click on 
Load.   The  image  displays  and  the  dialog  box  remains

active and partially obscures the image.   To remove the dialog
box from the screen, click on the (-) located in the top left corner of
the image and select Close.
  

2. You can click on another  filename and then click on  Load.  The 
second image displays as well.  However, the images cannot

be moved across the screen, which will get quite crowded.  

3. Another  way  to  browse  through  multiple  images  located  by  a  
specific  search,  is  to  click  on  OK instead of  Load.   This

displays the Catalog Entry dialog box with a thumbnail view of
the image in the upper left corner. 

4. One can scroll through the catalog by clicking on  Previous and  
Next.

It's  quite  possible  that  images in  other  catalogs will  qualify  under  your
search criteria.  After you have worked through the selected catalog, return to the
Browse/Search menu and use the up and down arrow to view other available
catalogs.   Click  on  another  one  and  restart  your  search  following  the  same
procedure you just completed.

Besides  View and  Load,  the  Browse/Search menu offers a variety  of
other  functions.   These options will  assist  you in editing and customizing the
catalogs  and  are  accessed  by  clicking  on  the  appropriate  menu  item in  the
Browse/Search dialog box.   



OK
The OK button provides access to the View Catalog Entry dialog box.  
1. Select Browse from the Catalog menu.

2. Click on OK in the Browse/Search dialog menu.  The View 
Catalog Entry dialog box appears. 

As  discussed  above,  you  can  scroll  through  the  catalog  by  using  the
Previous and Next buttons.  This dialog box also allows you to input certain data
about the image.  For further detail on the View Catalog Entry dialog box, refer
to the section entitled CREATING A CATALOG. 

Moving Images to Another Catalog
This procedure allows you to move an image out of one catalog and into

another.  It also explains how to duplicate an image and place the duplicate in
another catalog.

1. To place an image in another catalog, click on Move/Copy in the 
Browse/Search dialog menu.  The Select Target Directory

menu appears. 

2. To duplicate the image and place it in a different catalog, select  
Copy Only and then enter the names of  the new directory

and catalog.   This  action  results  in  a  copy  of  the  image
remaining in the current catalog and a copy of the image appearing
in the new catalog.  

3. To move the image out of the current catalog and into a new 
catalog, enter the directory and new catalog name and click on 

Move.  The image is deleted from the current catalog and is
now located only  in  the  new catalog.   Either  way,  the  catalog



entry is updated  to  reflect  any  changes  you  have  made,
including the new location and a new name if you have renamed
it.

Uncatalog Images
This  allows  you  to  remove  an  image  from the  current  catalog  without

placing it anywhere else.  The image is not deleted from the hard disk by this
action, just from the current catalog.

1. Go to the Browse/Search menu. 

2. Click on Uncatalog.   A Confirm Action dialog box appears.  

3.  To remove the image, press Yes; to cancel the action, press No.  

Delete File
This action deletes the file from the hard disk as well as the catalog.
1. To delete an image from the current catalog and the hard disk,  

click on Delete File.   A Confirm Action dialog box appears.

2. To continue, press OK; to abort, press Cancel.  

Print Cat
This button permits  you to  print  the entire  catalog,  with  or  without  the

descriptive data, to an output drive.  For further information on printing, please
refer to the section entitled PRINTING A  CATALOG.

Cat Info...
This button takes you to the  Statistics screen of your current  catalog.

There you will see information about the number of filenames in the catalog, how



many are active, how many have been deleted, and the number of bytes which
correlate to each of these data entries.  This screen also tells you how much free
disk space you have available should you wish to add more filenames to the
catalog or more catalogs to The Browser.  



Cancel
To close the  Browse/Search dialog box, click  Cancel.  Clicking on the

box in the upper left hand corner of the screen and selecting Close also closes
the menu. 

CREATING A CATALOG

The  Browser always  maintains  at  least  one  catalog,  the  Default.
However, you may add as many catalogs as your system's disk storage permits.  

ASSEMBLING  A CATALOG
To assemble a catalog, you must locate and identify the images you wish

to include.  You may choose images based on some criteria or just randomly.

 1. Go to  Catalog.   Click on  Select Catalog.  The Select Catalog  
menu appears.

 2.  Click on Create New under Catalog Action.  

 3.  Enter the name of the  New Catalog Title.   The name appears  
above the Thumbnail View and any printout you create.  

 4.  Using the cursor or the Tab key, go to Catalog File Name.  Enter 
an  alphanumeric  name  for  the  catalog,  8  characters

maximum.  The Browser creates two files in the directory: one
with the extension  .CAT and  one  with  the  extension
.CIX.

 5.  Using the cursor or the  Tab key, go to  Path and enter the  Drive 
and  Directory of  the  images  you  wish  to  place  in  the



catalog, i.e. C:\MCP\ANIMALS.  



Note: We suggest that the location of a catalog be in the same  

directory  as  the  majority  of  the  images  contained  in  the

catalog because the catalog's path also becomes the default

path for accessing the images.  

 6. If your catalog will contain only certain graphics formats, the 
Default File Extensions for files displayed in the File Open

dialog              box can be defined for each catalog.  

 7.  Using the cursor or Tab key, go to Volume. 

 8.  If there is a Volume Label, type in the Volume name of the drive 
where the images are located.  Should you be uncertain of

the location, go to the drive and type in the word Label.  It will
tell you the Volume name. If the volume has no label, ignore
this field.

Note:  A Volume Label is a MS-DOS command function.  For more 

information, please refer to your MS-DOS manual under Label or 

Format.  A volume may be optionally specified for a catalog.

If present, the volume name of the drive containing the catalog

will be checked prior to opening a catalog.  This option is quite

useful when  a  catalog  exists  on  a  removable  drive  such  as  a

Bernoulli box.  If the correct volume is not mounted, you will be

prompted to insert the proper volume.  

 9.  Click on OK.  Your new catalog is created.  

10. The New Catalog Created dialog box appears to ask if you want 
the new catalog to be your current catalog.  If you want to

work with the new catalog, click on  Yes.  If not, click on  No.  Either



way, your             new catalog will now be listed in the Catalog Title
display box.



BUILDING A CATALOG
Now that you have created a new catalog, it is time to place images in it.

This is done with the Build Catalog option in the Catalog Menu.  

1.  Click on  Build Catalog  to access the  Select Items to Catalog 
dialog box.   This contains the files that can be selected and 
added to the catalog.

 2.  Click on the Drive and then click on the 
Directory where your images are located.  

3.  Click on the filename of the desired image. 

4.  Click on the Build button and the image is read in and cataloged.
The catalog builds and the Catalog an Image dialog box is 

displayed.

Note:  If the file selected is already in the catalog you're building, 
clicking on it will not have any effect and it won't be added.

In other  words,  you can't  have two of  the  same image in  a
catalog.

Note:  There are several options available to simplify this process.  
These options are explained in more detail below.

5. The Catalog an Image dialog box contains a variety of user fields 
and  program  fields  with  important  information  about  the

image.  All of  the  fields  except  for  file  size,  date  created  and
format can be directly modified.

6.  Enter the required information in the user fields:

Title This  is  the  title  of  the  image.   If  a  GIF89a



image has a title, it will  be  filled  in  automatically.  The
maximum number  of  characters  that  can  be
entered is 59, including  carriage  returns  and
line feeds. 



Keywords  This field can contain a number of keywords,
up to the  length  of  the  entry  box,   to  be  used for
searching. These keywords can be used to select
a list of files meeting requested search criteria.  The
maximum number  of  characters  that  can  be
entered is 87. 

Description This field can be used to enter any descriptive
data concerning  the  file,  up  to  a  limit  of  1200
characters. This  field  can  be  scrolled  and  edited
using standard editing commands.   If  a GIF89a
image has text data included  with  it,  it  will  be
placed here. 

Catalog    Dropdown  combo  listbox  used  to  select  the
catalog to be updated.

7. Except for file size, date created and format, the program fields 
can be directly modified.  These fields include: 

Filename    The name of the file.  In the case of KODAK
photo CD's,  the  image  will  be  cataloged  with  a
pseudo name made up of the CD's creation time
(an eight digit  Hexidecimal  number),  with  an
extension of "nnn" where "nnn" is the image's number on
the Photo CD. This is because Photo CD's use
the same file names, e.g. IMG0001.PCD on every CD.

Pathname   The primary location (hard disk) pathname and
volume  label  are  displayed  as  well  as  the

backup (floppy disk) location.  Therefore, there
can be two access paths for the file. 



Primary 
Vol The volume name of the primary location.



Backup The  volume  name  and  path  of  the  backup  
& Path floppy disk.

Size        File size in bytes.

Date
 & Time Creation date and time of the file.

Info     The  height,  width,  number  of  colors  and  file
format are displayed in a box in the lower left
corner. 

8. When you are finished, press  Catalog.  This returns you to the  
Select Items to Catalog dialog box.  Repeat this process

until your catalog is assembled.  Then click on Done to exit from
the menu.

As discussed above, there are several  options available to simplify the
catalog building process.   These options are located on the  Select  Items to
Catalog box.

Show All
The  Show All box  is  actually  a  "cycling"  menu.   Clicking  on  the  box

changes it to the following options:
1. Show All lists all the files in the selected directory.

2. Show Cataloge changes the listbox display to only those files that 
are cataloged in the selected catalog.

3. Show Uncataloge changes the listbox display to only those files  
that are not in the selected catalog.



 
Select All

The Select All option selects all of the files in the listbox.  If there are only
a few files that you wish to exclude, you can then de-select them manually by
clicking on the  filenames.  This procedure is only useful if you wish to catalog
the majority of the files.  Otherwise, it is quicker and easier to select each desired
file individually.

 
Auto Update

Selecting the Auto Update options allows for fully automatic updating of
the selected files.  Leaving it off requires you to press the Catalog button after
updating the user fields information in the  Catalog an Image dialog box.  It is
more convenient to catalog manually if you are doing one image at a time.  To
establish a new catalog or to update a catalog with many images, the automatic
method is preferred.  

Stop on Error
The Stop on Error option can be turned on to bypass prompts for error or

warning messages such as when large 24 bit files are read.  

Force Update
If  you wish to reconstruct the thumbnail  for catalog entries that already

exist, you can turn on the Force Update option.  

Follow Directory Tree
To facilitate building all the files for an application or an entire CD-ROM

volume, the  Follow Directory Tree option can be turned on to list  all  files in
subdirectories of the current directory.



Catalog Build
When you  use  the  Catalog  Build command,  images  that  are  already

cataloged will not be read to create a new thumbnail.  However, the catalog entry
will be updated with backup volume and path information for files on floppy disk.  

Volume ID
If a floppy disk containing images is processed and the floppy disk is not

labeled, The Browser will prompt you and label the disk for you so the catalog
entry can indicate the Volume ID.

ACCESSING AND UPDATING CATALOG INFORMATION

Accessing Catalog Information
After  building  a  new  catalog,  you  can  access  it  and  edit  it.   This  is

accomplished by using the options located in the Catalog menu.  Earlier in the
manual, we explored the Catalog menu.  Let's briefly revisit it.

To access your new catalog use Select Catalog. 

Use the Browse Catalog option to view, sequentially, the contents of a  
catalog.   While  in  this  screen,  user  supplied  information  such  as  title,

description and keywords can be changed.  An important option that can also be
accessed is the Search function.  The scope of entries that will be displayed in a
catalog  can  be  modified  by  setting  search  criteria.   Besides  searching  on
keywords defined for each entry, a search can take into account such attributes
as file size, format, number of colors or date (see Appendix II, THE SEARCH
OPERATION). 



To update a catalog with a large number of entries, use the Build Catalog
option.  This can be done automatically, or the function can pause for each image
to  allow you  to  update  title,  description or  keyword information  (see  Auto
Update in the Building A Catalog section.
 

View the catalog by selecting the Thumbnail View option.  This displays
thumbnail images  of  cataloged  items  in  the  currently  displayed  window.
Scrolling  commands (either  from the keyboard or  mouse)  enable  the  user  to
browse through all of the entries in the catalog.  Click on a thumbnail image with
the right mouse button to display the Pop-Up Menu.  Click on Information.  The
View Catalog Entry screen appears and you can update the title,  description
or keywords.

User Note:  Information other than user supplied title, description and  
keywords is  automatically  updated when exercising  the  Catalog

Catalog (see  below)  or  Catalog  Build commands.  The  Catalog
Build command is particularly useful for updating a catalog with the location of
files.  For example, if you previously copied images to floppy disks, the
Catalog Build command could be used to update the catalog with
the backup locations of the files.

Multi-Catalog Updating
There  will  be  occasions  when  you  wish  to  move  an  image  from  one

catalog to another. This is very easy with  The Browser. There are three ways
that this can be done short of simply cataloging an image from scratch in another
directory. 



Catalog Catalog (Method #1)
Assuming that an image is already cataloged, use the  Catalog Catalog

command  to display the catalog entry.  Take note that in order to access the
Catalog Catalog command, you must load an image.  The  Catalog Catalog
command takes you to the Catalog An Image box.  Select a new catalog using
the  Catalog listbox  then  press  the  Catalog button.  This  method  has  its
drawbacks, however. The catalog entry in the original catalog is still present and
must be manually deleted if it is no longer desired.  Secondly, the original catalog
is no longer selected so, to continue working in that catalog, the original will have
to be re-selected.

Thumbnail View (Method #2)
A more efficient way of moving images from one catalog to another can be

invoked  via  the  Thumbnail  View command.   Individual  thumbnails  can  be
marked for some future action.  Then the  Process Thumbnails command can
be used to either Move, Copy or Delete all of the marked thumbnails.  Moving or
copying  thumbnails  to  another  catalog  does  not  entail  replacing  the  current
catalog  selection  so  that  operation  in  the  current  catalog  can  continue
uninterrupted.   

PRINTING A CATALOG
To print a catalog, select Print Catalog from the Catalog main menu.  The

Print dialog box is displayed.  This dialog box allows you to select one of the
following print range options:

1. All images in the catalog
2. A selected range of images
3. A range of pages

The  Print dialog box provides access to two other menus:  Setup and
Options.  The  Setup menu allows you to select a different printer and/or the
page size  and other  printer  options.  The  Options dialog  box allows you to



customize your print job.  Dialog box choices include:



Print Catalog using Thumbnails
The Print Catalog using Thumbnails option, if turned on, forces  
The Browser to  utilize  the  Thumbnail  image  that  is  part  of  the

catalog entry.  If this option is turned off, the image will be read from
disk prior to printing.   Reading from disk results  in  far  superior picture
resolution at the expense of the time necessary to read the images in.  It
also may be less convenient as you may have to repeatedly swap disks
to read images that do not reside on your hard disk. 

Dither when Printing
The Dither when Printing option should be turned on if the printer 
cannot  print  color  or  convert  to  grayscale.   In  that  case,  The

Browser  performs the necessary dithering.  This option affects both
printing of whole images as well as catalog entries.

Note:  The above options are saved in the WIN.INI file, by 

printer, so that when a new printer is selected, its options 

are established automatically.

Complete Entries and Thumbnails
The  Complete Entries  and Thumbnails  buttons allow for  the  
selection  of  different  printing  formats.   The  Complete  Entries

option prints  up  to  4  catalog  items  per  page.   When  the
Thumbnails format is selected,  only  the  thumbnails and  their
filenames are printed.  On 8 1/2 x 11 inch paper, you should be able to
print 20 thumbnails per page, assuming 3/4 inch top margins, 1/2 left,
right and bottom margins and a 1 1/2 inch thumbnail.



User Note:  Formatting the printed catalog.   By setting the  
margins  and  changing  the  size  of  the  thumbnail  that  is

printed, it is possible  to  format  the  printed  catalog  to  fit  various
paper sizes. For example, if you want to print on 5 1/4 x 8 1/2 paper,
change the margins to 1/2 at top and bottom, left and right  and
change the thumbnail  size  to  1  inch.  The  same  number  of
thumbnails can be printed  per  page  as  using  a  3/4  inch  top
margin, and 1/2 inch side and bottom margins  with  a 1 1/2  inch
thumbnail on a 8 1/2 x 11 inch piece of paper. 

Fonts
Pressing the  Fonts button allows you to select a  typeface and  
size  of  type for  the  catalog  print  functions.   Separate  font

information is established for each printer and will be used the next
time that the printer is selected. 

User Note:  Selecting a Font Style other than Regular does result in that 
style being used.  The Browser, however, determines which portions to 

print in bold or underlined text. 

Options Display and Print...
The  Options  Display  and Print... dialog  box  allows  you  to  scale  the

picture to the desired size. To aid in selecting the correct size, the size of the
image can be expressed as a percentage of the original or in pixels. Also, the
resulting size in inches or centimeters is displayed. The Browser assumes that
the image is comprised of square pixels and automatically scales the image to
avoid distortion if the printer horizontal and vertical resolutions are not the same. 

Please note  that  in  order  to  access the  Options Display and Print...
dialog  box,  you must  have an image loaded and the  loaded image must  be
selected as the active window if more than one window is opened.



Printing Catalog Entries
The first step required in printing a catalog is to select a printer and the

desired typeface and size of the entries.  Once you have done that,  there are
several ways to print a catalog entry:  

1.  Printing One Image
There are two alternative methods of printing one image:

A. From the  Catalog Browse dialog box select  
the desired image.  Click on  Print Cat.

This brings you to the Print menu.  Note that
the Print  Range option  is  automatically
selected.  All you have to do is click OK.

OR

B. If you want to view the image before printing, 
     select  the  desired  image  from  the

Catalog Browse dialog  box.   Click  on
View.  The image is now in full view.  Select
the Print option from the File menu.  If you
desire to print only a portion of the image,
use the mouse  to  draw  a  marquee
around the portion you wish to print.

2.  Printing all of the Images in the Current Catalog
To print all the selected entries in the current catalog:

A. Select the desired catalog.
B. From the Catalog Menu, select Catalog Print.



 
3.  Printing only Marked Images

This option is very useful if you want to print some of the  
images in a category, rather than all.  
1. Access the pop-up menu in Thumbnail View.  
2. Mark the thumbnails you want to print.
3. Select  the  Print option  from  the  Process  

Thumbnails Menu.  This command will
print only marked entries.  It is the best way
of printing specific items to print.   

4.  Printing a Range of Images
One doesn't have to print all the images in a catalog.  Use 

the  Catalog  Browse/Search commands  to  narrow
the scope  of  the  catalog  to  images  which  meet  your
specific criteria.  

MAKING THE MOST OF THE BROWSER

DISPLAY IMAGE OPTIONS
The Browser permits you to make several choices about how images are 

displayed on your screen.  These options are accessed on the Menu Bar under 
Options.

Center Image
If  a  window is  expanded  or  a  full  screen  view is  selected,  the  image

displayed is located in the upper left-hand corner of the window.  Selecting the
Center  Image option  centers  all  images smaller  than the size of  the  current
window both horizontally and vertically.



Stretch to Fit
When activated, this option causes images to be stretched or shrunk, 

keeping the proper proportion or aspect ratio, to fit the current window's size.  

Auto Dither
Images can be read in several resolutions: 

1 BPP 1 bit per pixel or two colors, black & white. 
4 BPP 4 bits per pixel or 16 colors. 
8 BPP 8 bits per pixel or 256 colors. 
24 BPP        24 bits per pixel or 16 million colors.  

The number of colors displayed is determined by the maximum number of
colors that your video display and driver software can handle.  The Browser
retains all color information in an image even if all the colors can't be displayed
on your monitor.   For example, if you are using the standard VGA driver that
comes with Windows, you can only display the 16 colors that Windows uses.   If
you read an image that uses 256 colors, most of the colors will  be displayed
using the nearest color.   The result is unacceptable in many cases. 

The Browser offers a remedy for this situation with its Auto Dither option.
Dithering is a way of simulating the display of many colors by substituting various
combinations of the 16 colors.  It fools your eyes so that the image appears to
have more shades of color than can be actually displayed. 

Turning  on  Auto  Dither forces  The  Browser to  automatically  dither
images for display if they have more colors than the display can present.  It only
operates on a device that does not have the capability of displaying all of the
colors in an image.  For more information, see Dithering below.



Background Color
When the size of an image is increased, the additional area of the image

is painted to the background color that is set by the Background Color option.
You may choose that default through the Options Menu as follows: 

1. Click on Background Color.. in the Options menu.  A color 
 chart is displayed.  

2. Choose  one  of  the  Basic colors  and  click  on  Define  Custom  
Colors.  A custom color palette is displayed. 

3. Make your adjustments by moving the arrow in the far right 
      portion of the screen up and down with your mouse cursor.  

      Once the color is acceptable, click on Add to Custom
Colors.       That  color  is  now  displayed  in  the  Custom  Color
boxes.  

4.  Click on the color box, then click on OK.  It will be the new 
     background color.

Palette
Each image that is displayed possesses a palette.  This palette is a list of

colors that are used to display the image.   In most cases, the palette is limited to
some particular value that is directly proportional to the color resolution of the
image.  This is generally 2, 16 or 256 colors.  If your video card supports 24 bit
color, the palette can contain more than 16 million colors.

The majority of video cards are capable of displaying only 256 colors or
less at a time.   Nevertheless, these 256 colors are not fixed but can be any one
of 256,000 different colors.  The purpose of the palette is to tell the video display
which 256 of the possible 256,000 colors will be used.



The palette makes it possible for you to change the colors in the image.
Two of  the  most  common palette  operations  are  adjusting  the  contrast and
brightness of  an  image.    By  making  all  of  the  colors  more  intense,  the
brightness of the image can be adjusted.   Likewise, by adjusting the darker
colors unequally, the contrast of the image can be adjusted.

Many scanned images contain a wider range of color than can effectively
be displayed by many video displays.   If an image is too dark, brightening it or
adjusting the contrast may bring out details that otherwise could not be seen.
The Browser can easily handle such adjustments utilizing the  View Change
Palette command.   A  Complementary  command  is  the  View  Gray  Scale
command which can be used to convert a color image to shades of gray. 

User Note:  In  order to  access the  Palette Menu,  you must load an  
image.

Color Resolution
Normally, the user will not wish to change the color resolution of an image.

In some cases, however, there may be good reasons for doing so.  It is safe to
say that the most efficient storage of an image takes place when the number of
colors used in the image is less than the color resolution and greater than the
next  lowest  color  resolution  value.  Generally  images  are  stored  as  1  bit  (2
colors), 4 bits (16 colors), 8 bits (256 colors) or 24 bit (16.8 million colors).

Little is gained by reducing the color resolution of an image as this results
in a loss of color information.  Likewise, increasing the color resolution increases
the storage space requirements while providing no additional color information. 



The most rational exception is converting 24 bit images to 8 bit images.
Unless you have a 24 bit video display, there is little need to retain the extensive
color information contained in 24 bit images.  The 24 bit video display usually is
reserved for commercial printing applications.  The display of 24 bit images on
the usual VGA or SVGA or even 8514 video display is very time consuming.  For
that reason, you may want to convert a 24 bit color image to 8 bits to facilitate
viewing it at a later time.  The Browser can easily handle this conversion in File
Save.

Sometimes images are written in 256 color format but  only contain  16
colors or less.  In this case, the disk space taken up by the image could be
substantially reduced by reducing the color resolution to 16 colors (4 bits).

Dithering
Another option that can be utilized to convert, for example, a 24 bit image

to  8  bits,  is  the  Palette  Dither command.   While  dithering  can  take  a
considerable length of time, the results can be quite good.  Dithering initiated by
the Palette Dither command as opposed to the Auto Dither option permanently
changes the color resolution of the file.  The  Auto Dither option, on the other
hand,  only  dithers the image for  display on a device that  does not  have the
capability of displaying all of the colors in the image.

The  degree  of  dithering  is  controlled  by  the  palette  selected.   If  you
choose  Black and White, the dithered image will  only contain 2 colors.  This
may be desirable in preparation for printing since most printers, (color printers
excepted), only print black or white and don't know what to do with shades of
gray  (note that most of the print drivers distributed with Windows 3.1 do a good
job of printing color images as halftones and do not require that the image be
dithered to black and white first). 

You can choose Color (use current palette) when a 24 bit image is displayed.
This  will  most  likely  be  a  256  color  palette.   Choose  16  Color  palette for



displaying images on a 16 color video display and if you wish to save the image
with 4 bits per pixel color resolution.  

Choose  20  color  stock  palette to  display  images  with  the  Windows
standard 20 color palette and with video drivers such as the standard VGA driver.
The 256 color palette has an even distribution of all colors. This palette may be
used to provide a common palette for cutting and pasting several images that
have different palettes.  

If you wish to use  the palette of another image in the Clipboard palette,
you may do so by copying the image with the desired palette to the clipboard.
This also copies the image's palette to the clipboard.  A palette from the clipboard
may be used to provide a common palette for cutting and pasting several images
that do not have the same palette.

CREATING A NEW IMAGE

The Browser provides for the creation of a completely new blank image
which can then be edited.  For example, you wish to combine several images into
a composite image.  The way to do this is to create a blank image of the desired
size by utilizing the File New command.

1.  New Image Dimensions
The default dimensions shown in X Dimension and Y Dimension 

will be that of the window size before you select File New. If
you
              know the size that you want the new image to be, you can 

manually enter the desired X and Y dmiensions.  The Set to 
Windows and Set to Clipboard buttons sets or resets the X and Y
values to that of the current windows or Clipboard image (if any).
Select Clipboard if you want the new image size to be the same



as the image in the clipboard.



2.  Color Resolution
The color resolution of the new image defaults to 1 bit per pixel.  If 

you want more than two colors, select a different value.  The
value selected is the maximum number of colors that the image
can contain.  The Initial palette of the new image defaults to the 

Windows default palette.  This palette contains 16 colors
unless you  have  a  Super  VGA or  higher  resolution  video
driver.   In that case it contains 20 colors.

You may also select a 256 color palette that contains a default set 
of colors.  If there is a palette stored in the clipboard, you

also can select  it  as  the  palette  for  the  new  image.   It  is
recommended that you use the palette from the clipboard if  it  is
available.  This eliminates  the  need  to  convert  the
image when an image in the clipboard  is  pasted  to  the  new
image. 

3.  Create The New Image
Now paste the contents of the clipboard to the new image.

Switch to another window of The Browser or another application to copy
the remaining images that you want to combine to the clipboard.   Repeat steps 2
and 3 above as often as necessary and then select  File Save to save the new
composite image.

SAVING AN IMAGE 
Occasions may arise where you wish to save an image displayed by The

Browser because you have edited or changed it in some way.  Or you may want
to change the format or color resolution of the image, as stored on disk, to some
other  graphics  format.  These  needs  can  be  satisfied  by  the File  Save-As
command.  



 Standard Window commands Cut and Copy do not interpret the image
data  as  stored  on  disk.   In  contrast,  File  Save creates  a  disk  file  from the
currently displayed image.  

The format of a saved image can be established in several ways.  First,
the  extension provided  for  the  output  file  can  be  used  by  The Browser to
determine  the  desired  format.   Secondly,  the  File  Save dialog  box  offers  a
number of graphic format selections to use.  See  Appendix 1 on GRAPHICS
FORMATS.

EDITING AND MANIPULATING IMAGES
The Browser possesses a modest set of tools that allow images to be

edited and manipulated.  These tools make it possible to perform a variety of
actions.  Before you begin experimenting with these tools,  note that once an
image is edited, it must be saved and reloaded to be edited again.

Crop or Trim
In order to  Crop or  Trim excess portions of an existing or new image, several
techniques can be used.  

1.   Place the cursor on the desired upper left-hand corner of the 
      resulting image and hold down the left mouse button.

2.   Move the mouse to the opposite corner of the desired portion of  
      the image.   A rectangle, called a marquee, is drawn on the 

     screen.  If the marquee is not in the desired location,
redraw it      until you are satisfied.  

3.  When the marquee is stretched out to the desired extents, 
      release the left mouse button.

4.  Select Edit Crop.  The image is trimmed to the area 



     encompassed by the box.  If the image needs to be trimmed 
     only on the right side and/or bottom, the window borders

can be           moved by using the mouse to drag the borders to
the desired      place.

Expanding The Size of an Image Border
You may wish to expand the size of an image borders so that the borders

are extended without otherwise changing the size of the image.

1.   Drag the  window borders  to  make the  window the  desired  
     size. The image is centered in the middle of the new  

     window.

2.  Select Edit Expand to expand the image. The area 
     added to the window is set to the currently defined 
     background color (see Option Background on how to 

     set the background color). 

Resizing An Image
In the preceding discussion on expanding images, no changes were made

to the actual image size.  However, the overall size of the window in which the
image is displayed was changed.

It is also possible to stretch or shrink an image.  If desired, this can be
done  independently  for  each  axis  (left-right  or  top-bottom).   This  may  be
desirable to achieve some artistic effect or to compensate for distortion caused
by conversion from another graphics format. 

Resizing is done by replicating or eliminating pixels.  This is an important
point to keep in mind.  The best results are obtained when the shrink or stretch
factor is some integer multiple of the original image, such as times 2 or divided
by 2, etc.  Using a fractional factor will result in distortion of the image, although



this  effect  could  vary  depending  upon  the  details  of  the  image.   It  may  be
particularly noticeable if the image contains a repeated pattern.



There are two methods that can be used to resize an image.

Resize Method #1
1.  Select the Edit Resize command and enter the desired 

     dimensions.  Note that the default dimensions displayed
are      those of the current window.

2.  Resizing can be done independently on either the X or Y axis.  
     The  resizing  factor  can  be  specified  either  as  a

percentage or in                   terms of absolute pixel dimensions.

Resize Method #2
1.  Stretch the window frame to the desired size before selecting 

     Edit Resize.

Resize Method #3
1.  Place the cursor on the image and use the left mouse button to 

     draw a marquee encompassing the area to be resized.

2.  Using the right mouse button, draw a marquee to delineate the 
     new dimensions of the selected region.

3.  When you release the right mouse button, the image will be  
     overlaid  with  the  stretched  or  shrunk  region.   The

resulting      image can then be cropped as desired. 

User Note:  In order to stretch to dimensions larger than those of the  
current image, you should first expand the image so that there will

be sufficient room for the stretched image.  It is possible to rotate an
image in 90°  increments  and  to   flip  or  mirror  the  image  about  its  X
(horizontal) or Y (vertical) axis via the Edit Resize command.



User Note:  Microsoft Windows may alter the size of a window when the 
Window Tile or  Window Cascade  menu options are selected.  To
restore a window to the dimensions of the image, select the  Size

Window to Image selection from the Window menu.

All  of  the preceding editing commands primarily affect an entire image.
Additional editing operations using the Windows Clipboard can be used to cut
or copy all or part of an image to the Clipboard.  The data in the clipboard can
then be pasted to another application or the current application.  Likewise, other
applications can copy data to the clipboard and it can then be pasted by  The
Browser.  

Other Editing Notes
The Browser will copy both a DIB and device dependent bitmap to the

clipboard.  The Browser can accept the same two formats from the Clipboard as
well as a Windows MetaFile format.

The  Browser automatically  converts  an  image's  palette  and  color
resolution so that, for example, a 16 color image can be pasted onto a 256 color
image without corrupting the colors.  If the clipboard image being pasted has a
different color resolution than of the current image, you can choose to  convert
the current image to the higher resolution or dither the clipboard image to the
lower resolution.



MAXIMIZING THE FEATURES OF WINDOWS

Object Embedding and Linking
Many  Windows 3.1  applications  support  Microsoft's  Object  Embedding

and Linking (OLE)  protocol as a server, client or both. The Browser is an OLE
server application and can supply images to an OLE Client application such as
Windows Write or Word For Windows 2.0.  To determine whether an application
is  an  OLE client,  look  to  see whether  any of  the  following menu entries are
present in your application's Edit menu: Paste Special, Paste Link, Links, Object
or Insert Object. 

If  your  application  is  an  OLE  client,  it  can  import  images  from  The
Browser using  OLE.   An  image  in  The  Browser can  be  included  in  your
application by using a  Link (via  the  Paste Link  command)  or  embedding the
image using the Insert Object command. 

Links
In order to link to an image perform the following steps:

1.  Start  The Browser.  View the image as you normally would.  

2.  Copy the image to the clipboard and then in your application.  

3.  Select Paste Link.  The image will then be inserted into your  
     application.

Your application will maintain a link to The Browser so that if the image is
changed, it will be automatically updated in your application. 



Embedding
Follow these steps to embed an image.

1.  Select the  Insert Object command on your application's  Edit 
     menu.

2.  If it is not already running, select  The Browser icon.  This  
     will automatically start The Browser.

3.  Select a Thumbnail  view and then double click with the left  
     mouse button on the desired Thumbnail  to  view the

image.

4.  Select Update from the File menu to insert the image into your 
     application.

5.  Subsequently, you can double click on the embedded image in 
     your application to start The Browser to edit the image.

Refer to your application's documentation for more specific information as
to how OLE is implemented.

Slide Show.  
You may opt to view images, or some of the images, as a  Slide Show.

The images display sequentially based on an order you determine.   Here's how
to arrange your Slide Show:

1.  Select a catalog and access the images via Thumbnail View.



2.  Choose the desired images by marking them.  There are two ways to 
      do this.
Marking Method # 1

Mark each image individually by placing the cursor on it,  
clicking the right mouse button and then clicking the

Mark Thumbnail option.   The marked image displays an
asterisk * next to the filename in the title bar.   You can
Unmark the file  by  following  the  same  procedure.   The
asterisk will disappear.

Marking Method # 2
Click on  Process Thumbnails in the  Options Menu and  

work  through  the  Process  Thumbnails dialog
screen.   In this screen, you can Mark or Unmark all items.

3.   Once you have marked the desired images, access the  Options  
      Menu and click on Slide Show.

 
Several options can be set that will determine the operation of the Slide

Show.  These options can be set via the  Catalog Slide Show Options menu
accessed through the Options menu.  Options available include:

Delay between slides
This programs the minimum amount of time that an image will be 

displayed.  The image will  be displayed an additional  amount  of
time while the next image is loaded.  The delay time is expressed in  

milliseconds (10000 = 10 seconds).

Number of animation passes
This value establishes how many times an animation sequence (FLIC or 

GIF89a) will repeat before going to the next slide.

Display filename



If  this  box is checked,  the filename of  the image being displayed will  
appear in the upper left-hand corner of the screen.

Pause between
This option gives you manual  control  of  the slide show.  If  the box is  

checked, slides will not automatically advance from one to another.
The right mouse button must be double-clicked to proceed.

Repeat Show 
Your show is probably awesome.  To start over at the beginning when the 
list of marked slides has been displayed, check this box.  To terminate the 
slide show,  double click with the left mouse button.

Cursor  
If you want the cursor displayed during slide show, mark this option.

Here are a few other items worth noting while using Slide Show:
1.  During a slide show, double clicking with the left mouse button 

     will terminate the slide show.

2.  GIF89a animations that require user input can be advanced to 
      the next frame by clicking the right mouse button.

3.  To create the smoothest running slide show, it is suggested that 
     all images be converted to Windows BMP format.  This will  

     result in the fastest load time for the individual slides. 

4.  Files to be displayed must exist on a non-removable drive.

Run-time Options

There will, no doubt, be an occasion that demands a certain flexibility from
the The Browser.  As such, certain options are offered to help you customize the



program.  These options may be accessed via the Options main menu. 



Display Warnings
In  some  cases,  it  is  necessary  for  The  Browser to  issue  warning

messages to the user.  Once you become familiar with The Browser, you may
find these warnings to be more of an irritation than a help.   To suppress all but
the most serious errors and warnings, select this option.

Display Status Bar
This option controls whether the status bar will be displayed initially.

Center Image
If a window is expanded or a full screen view is selected, the image being

displayed will be located in the upper left-hand corner of the window.  Selecting
the Center Image option will cause all images that are smaller than the size of
the current window to be centered both vertically and horizontally in that window.

Stretch to Fit Window
This option controls whether images will be created with the "Stretch to

Fit" option active.  If active, the image will be stretched or shrunk (keeping the
proper aspect ratio) to fit the current window's size.

DIB to Screen
The Browser normally will attempt to maintain both a device independent

bitmap  (DIB)  and  a  device  dependent  bitmap  (DDB)  for  any  image  being
displayed.   Display of DIBs is slower, especially when it is a 24 bit color images.
However, initial creation of the DDB can also be time consuming.

For  this  reason,  it  is  best  to  allow  The  Browser to  create  a  DDB.
However, in situations where memory is low, there may not be enough memory
to create a DDB.  By selecting the  DIB to Screen option, the user will  forgo
creation of a DDB and the DIB will be displayed directly to the screen.



Auto Dither
Some  display  drivers  aren't  capable  of  displaying  256  colors.   The

standard VGA driver,  for example, only displays 16 colors.  The  Auto Dither
option  causes  images  that  contain  more  than  16  colors  to  be  automatically
dithered for display only.  Note that the original image data containing 256
colors is not modified and, if the file is saved, none of the colors will be
lost. 

If you wish to dither an image and save it as a dithered image you must
select one of the Palette Dither options.

Dithering  is  a  slow process.   Thus,  you may wish  to  keep this  option
turned off until you specifically wish to view an image dithered.  How slow is it?  If
you have a 256 color driver, the Auto Dither option will cause 24 bit color images
to be dithered but this may take a very long time, perhaps as much as an hour.

Verify Catalog
If it is suspected that the catalog index has been corrupted, turning this

option on temporarily will force the catalog index entries to be verified with the
matching catalog record.  Invalid indexes will then be removed.

Fix TIFF  
If your TIFF file doesn't display properly try clicking on this option.  This

option places special rules for TIFF files into effect.

Background Color
When the size of an image is increased, the additional area of the image

will be painted to the background color that is set by the Set Background Color.
The background color is also used to paint the surface of an image created with
the File New command.



A dialog box is presented which enables the user to set the background
color  to  whichever  color  is  desired.   You can use the  Color  Solid option to
determine  whether  backgrounds  will  be  painted  with  solid  colors  or  dithered
colors.   The  dithering  option  may  give  a  wider  apparent  range  of  colors
particularly if the palette is limited to, say, 16 colors by the video display.

You  can  also  define  custom  colors  which  will  be  saved  for  the  next
execution of The Browser.

StartUp Options

You can program certain default options to go into effect whenever  The 
Browser is  started.    The  Startup  Options  menu  can  be  accessed

through the  Options main menu.   Many of the startup options are identical to
those found on the Options menu, which was discussed above. Startup option
choices include:

Default Catalog  
This option specifies which catalog will be selected initially.

Default Extensions  
This option specifies the file extensions of all files that should be 
displayed on a file selection list.  The value of this option is used in

turn as  a   default  for  establishing  a  similar  option  whenever  a  new
catalog is created.

Default Directory  
If this option is utilized, it will specify the current path that will be



displayed whenever the file open dialog is accessed.  Otherwise,
the path of the default catalog will be used.

Center Image  
  Selecting the Center Image option will cause all images that are 
smaller than the size of the current window to be centered both

vertically and horizontally in that window.  See explanation above in
Run-time Options section.

Display Warnings  
Select this warning to suppress all but the most serious errors and 
warnings.

Solid Background Color  
This option determines whether backgrounds should be solid or  
dithered.

Display Status Bar
This option controls whether the status bar will be displayed 
initially.

Stretch to Fit Window
See explanation above in Run-time Options section.

DIB to Screen  
See explanation above in Run-time Options section.



Fix TIFF  
See explanation above in Run-time Options section.

Auto Dither
Selecting  his  option  ensures  that  images  will  be  automatically  
dithered if their color resolution is greater than that of the display.

See explanation above in Run-time Options section.

Verify Catalog
See explanation above in Run-time Options section.

Disable Options
The Browser offers you the ability to disable various file formats  
like CGM, DRW, WPG, etc.

Command Line Options

Several command line options can be specified that affect the operation of
The Browser.  These options include:

1. Initial image to display

2. Initial catalog

3. Display thumbnail view

The format of command line options is:
BROWSER.EXE <file name>, <catalog name> <-v>



"file name" is the fully qualified pathname of an image to display.

"catalog name" is the title of the catalog to be used initially. If present, it 
will override the default catalog.

"-v" or "/v" can be specified to start a thumbnail view. 

Examples:
BROWSER.EXE abc.gif (load "abc.gif" on startup)

BROWSER.EXE ,Test Catalog ("Test
Catalog" will be the initial 

catalog)
BROWSER.EXE ,Clipart -v ("Clipart"  will
be the initial thumbnail
view)
BROWSER.EXE -v (the  default
catalog will be the initial view)

Removable Media
The Browser normally considers fixed media such as hard drives and

network drives as primary storage media and "removable" drives such as floppy
disks as "backup" locations.  In some cases, for example when using a Bernoulli
box  (which DOS considers as "removeable"),  you may wish to change the way
that The Browser treats such drives.

If you wish to consider a particular drive as a primary storage location,
with  Notepad or  some other  text  editor,  add the following option to  the  [The
Browser] section of your WIN.INI file:  Primary Drives=x,... where "x" is the drive
letter of the drive to be considered "fixed".   More than one drive can be thus
overridden; you do not need a comma after the last drive.



If you wish  The Browser to treat a drive as removable, for example to
store backup copies on a network drive, add the following option to your WIN.INI
file:  Backup drives=j,... As in the above case, you do not need the comma after
the last drive letter.  Example:  Bernoulli Drives E and F are to be considered as
primary storage even though DOS says they are removable.  Network drives J
and  K  are  to  be  considered  "backup"  drives.   Primary  Drives=E,F;  Backup
Drives=J,K.

The  Catalog  Select  Catalog command provides  for  specification  of  a
volume ID for  a  catalog.  If  present,  the  volume ID will  be  checked  before
opening the catalog.

Profile Options

The Browser will normally keep its configuration options following a [The
Browser] header in your WIN.INI file.  In some cases, this may not be desirable;
for example, in a network environment where several different users are using
The Browser. 

As an option,  The Browser may be configured to keep its options in an
alternative  location.   If  a  file  named  "THE  BROWSER.INI"  exists  in  the
subdirectory that The Browser is loaded from or in some directory in the PATH,
The Browser will maintain its options there and ignore WIN.INI.   In this case,
references to WIN.INI mentioned in this documentation will actually refer to THE
BROWSER.INI. 



APPENDIX I       FORMATS

Supported Formats

Graphic formats supported by The Browser include: 

AVI Video For Windows video and sound clips (Read only)
BMP/DIB Windows bitmap format 
CGM Computer Graphics Metafile (read only)
CLP Windows Clipboard file
DRW/GRF Micrografx vector file formats (read only)
EPS Encapsulated  Postscript  embedded  TIFF  preview

images (Read Only) 
FLI/FLC/CEL Autodesk Animator FLI/FLC animation files (Read only)
GIF CompuServe  Graphics  Interchange  Format  (The

Browser  supports both the GIF87a and GIF89a standard)
("The  Graphics  Interchange  Format  (C)  is  the

Copyright property of CompuServe Incorporated. GIF(sm) is
a Service Mark Property of CompuServe")

JPG JFIF format JPEG compressed images
ICO Windows Icon (Read only)
ICS Image Cytometry Standard files (Read only)
IFF/LBM/CE Deluxe Paint II LBM & IFF files (The file extension "CE" is

created  by  Digital  Vision's  Computer  eyes  video  capture
product) 

IMG GEM/IMG (Digital Research) format (Read Only)
MAC Macintosh MACPAINT files (Read Only) 
PCD KODAK Photo CD images  (Read only)
PCT Macintosh PICT bitmap graphics (Read only)
PCX Z-Soft Paintbrush files
RLE CompuServe Run Length Encoded file format
TGA Targa  file  format   (TrueVision  Advanced  Raster



Graphics 



Array) 
TIFF Tagged Image format 
WMF Windows Metafile
WPG WordPerfect  Graphics  WPG  files  (output  bitmap

format only)

Additional  formats  can  be  supported  by  The  Browser by  utilizing  the
Graphics  Import  Filters  that  are  supplied  with  Word  for  Windows  and  Aldus
Pagemaker.  Some of the available formats include: HPGL, AutoCad DXF and
Excel graphs.

The Browser can be used to change the format of an image from one
format to another.  This is useful when you have an image that you wish to input
to another program that doesn't support that format.  In this case, read the image
into The Browser and then save it to the desired format.

The Browser images may be saved in the following formats:

GIF87a CompuServe Graphics Interchange Format
TIFF  Tagged Image Format
PCX Windows paint
TGA Targa
BMP Windows bitmap format in either compressed or RLE format
IFF Amiga IFF (Also Computer Eyes .CE) 
JPEG JFIF format JPEG compressed images
WMF Windows metafile



Disable Browser Formats
Several image formats supported by The Browser are also supported by

Graphics Import Filters shipped with WINWORD and Aldus Pagemaker.  If you
want to use these filters instead of the built in support for these formats, you can
disable the The Browser read routine.  In this case, The Browser will utilize the
graphics filters defined in WIN.INI in the section: [MS Graphics Import Filters]. 

An example is reproduced below:
[MS Graphic Import Filters]
Windows Metafile(.WMF)=D:\WINDOWS\MSAPPS\GRPHFLT\wmfimp.flt,WMF
DrawPerfect(.WPG)=D:\WINDOWS\MSAPPS\grphflt\wpgimp.flt,WPG
Micrografx  Designer/Draw(.DRW)=D:\WINDOWS\MSAPPS\grphflt\
drwimp.flt,DRW
AutoCAD Format 2-D(.DXF)=D:\WINDOWS\MSAPPS\grphflt\dxfimp.flt,DXF
HP Graphic Language(.HGL)=D:\WINDOWS\MSAPPS\grphflt\hpglimp.flt,HGL
HP Graphic Language(.PGL)=D:\WINDOWS\MSAPPS\grphflt\hpglimp.flt,PGL
ComputeGraphics  Metafile(.CGM)=D:\WINDOWS\MSAPPS\
grphflt\.cgmimp.flt,CGM
Encapsulated Postscript(.EPS)=D:\WINDOWS\MSAPPS\grphflt\epsimp.flt,EPS
Tagged Image Format(.TIF)=D:\WINDOWS\MSAPPS\grphflt\tiffimp.flt,TIF
PC Paintbrush(.PCX)=D:\WINDOWS\MSAPPS\grphflt\pcximp.flt,PCX
Lotus 1-2-3 Graphics(.PIC)=D:\WINDOWS\MSAPPS\grphflt\lotusimp.flt,PIC
AutoCAD Plot File(.PLT)=D:\WINDOWS\MSAPPS\grphflt\adimport.flt,PLT
Excel Chart(.XLC)=d:\aldus\usenglsh\filters\CHARTIMP.FLT,XLC

User Note:  in the example above, "HP Graphic Language" is listed twice
because there are two file extensions in use for these files. You may have to edit
WIN.INI  to  do  this.   However,  the  WIN.INI  section  should  be  automatically
established whenever you install an application like WINWORD that includes the
filters.

User Note:  All of these options can be set by accessing the  Start-Up
Options menu via the Options menu.





APPENDIX II THE SEARCH OPERATION  

File Search 
Four different search criteria can be applied to a catalog to restrict the

catalog list to a subset. The four categories  that can be used for the search are: 
1.    Whether a backup copy exists

2.    File Format, e.g. GIF87a, TIFF, PCX, etc, as they appear in the "info"
      box on the catalog display.

3.    Match on one or more keywords. 

4.    Match on special conditions, e.g. file size, width, height, number of
                  colors or backup volume name. 

The Search function can be accessed by:

1.  Clicking on the Catalog menu.

2.  Clicking on Browse Catalog...

3.  Clicking on the Options>> button 

To search, enter the desired search value(s) in either the Format edit box
(29 characters max.), Special Conditions (87 characters max) or the Keywords
(87 characters max) edit box.  If nothing is entered in a box, it will not be used in
the search.  The  Backup File checkbox is a three-state control.  If the box is
gray, then it will have no effect on the search. 



If an edit box is blank, then all catalog records that do not have a backup
location will be selected.  If the box is checked, only those catalog records with a
backup file location will  be selected.  The three search criteria are combined
(ANDed) to  select  a  record.   That  is  to  say,  if  search criteria  1  (Backup)  is
satisfied AND search criteria 2 (File Format)  AND search criteria 3 (Special
Conditions) AND search criteria 4 (keywords) are satisfied, the record will be
selected. 

Wildcard characters "*" & "?"   can be used in search arguments.   For
example, to select all GIF files, the search argument GIF* will select both GIF87a
&  GIF89a".   Either  spaces  or  commas  may  be  used  to  separate  search
arguments.

The underscore character "_" may be used in place of a space in a search
argument if that space is significant.  For example STAR_TREK will search for
the string "Star Trek" while STAR TREK will hit on either "Star" or "Trek". 

Case is not significant in searches.   A logical AND operator '&' can be
used to separate two search criteria.   In this case, both search tokens must be
found in order for the record to be selected.   For example, if you want to select
the keywords, CLIPART and ANIMALS, use CLIPART&ANIMALS as the search
criteria.

In order to include in the search special conditions such as file size, image
width, etc, The Browser has 5 special search arguments that can be used in the
Format and Special Conditions boxes.  Don't use any of these special codes in
the Keywords box!  The special codes all start with an @ sign followed by a Code
for the particular value to be tested for, an operator ( "<" - less than, "=" - equal .
"#" - not equal, or ">" - greater than), followed by the value to be tested for. 



The valid codes are: 

"B" - backup volume name. 
"C" - number of colors, 2, 16, 256
"D" - date in format mm-dd-yyyy 
"H" - height of image
"P" - primary path name 
"S" - file size in bytes. 
"W" - width of image. 

Some examples: 
@W=320 select images whose width is 320 pixels.

@D>01/01/1991 select all dates later than January 1,
1991.

@B=GIF0020  select all  images residing on backup
volume "GIF020."

@C>16 select  all  images  with  more  than  16
colors.

@P=C:\THE BROWSER select  all  images  in
subdirectory "C:\THE BROWSER." 

The catalog will be searched for records meeting the desired criteria when
the Search button is pushed.  At the completion of the search, the new catalog
list  will  be displayed in the listbox.  To change the search criteria,  enter new
search values and press Search again.

The modified catalog list will  be in force until
the  Show All button is pressed, a new catalog is selected or another search
operation is performed. The  View Thumbnail View command will only display



the currently selected catalog entries.  

Launch Application
This  command  can  be  used  to  start  up  another  application  using  the

selected image. You will  be prompted for the program path/name and for any
additional parameters.

The Browser will append the file name and parameters together to the
contents of the Program box to be used as the command line for starting up the
application.

A default for "Program"can be established for a particular file type, e.g. "GIF"or
"PCX",  etc.,  by  adding  an  entry  to  the  The  Browser section  of  WIN.INI  as
follows:

xxx=[drive][path]{program},[parameters] (where "xxx" is the file type: GIF, PCX,
BMP, etc).

Windows Notepad or SYSEDIT can be used to edit WIN.INI. 



APPENDIX III      PRINTER TROUBLESHOOTING

The Browser relies on Windows print drivers to implement many aspects
of  printing.   If  you  experience  problems  (Error  during  NEWFRAME,  GPF's,
corrupted printouts, etc.), review the following discussion:

1.  Do you have sufficient disk work space?  Some print drivers require 
     that you have as much as 4 or 5 megabytes of free disk space

per      page of print.

2.  Do you have sufficient printer memory?  Your printer should be able to 
     print a page of text including some included graphics.  However, 
     printouts such as the catalog thumbnail print or a full page print

of a      photographic  image  probably  will  require  additional  printer
memory.       This is especially true of laser printers where you may
need 4      megabytes  or  more.   If  you  have  additional
memory installed in your      printer, make sure that you have informed
the printer driver that the      memory is installed.

3.  Do you have sufficient memory in your PC?  Many print drivers build 
     "Metafiles" in memory before sending the data to the printer.  The print 
                                        operation may fail if there is not enough

memory or your swap file is      not large enough.

4.  Do you have the latest printer drivers for your printer?  If you have had 
          Windows installed for some time, there may be newer versions

of print      drivers available for your printer that correct problems
and/or offer      faster  or  more  efficient  printing,  possibly  with  lower
hardware      requirements.  Contact your printer manufacturer
or Microsoft for      updated printer drivers.  Drivers also, can be found
on on-line services           such as CompuServe or on many BBS's.

5.  In some cases, a printer driver for another printer may work better.  
     This is especially true in cases where a printer "emulates" some



other      printer.  For example if you have a hypothetical "Ajax" laser
printer      that emulates a Hewlett  Packard Laserjet  III,  the HP
drivers may work      where the Ajax drivers don't.  

6.   When printing to a Network printer,  bypassing Print  Manager may  
      improve printing time and reduce memory and disk space  

      requirements on your PC.  There is an option in Print
Manager that       controls this.



APPENDIX IV

Exporting Catalog Information

The Browser supports a way of exporting catalog information for use in
other programs via the  Catalog Export command.  The text data incorporated
into  a catalog  entry  is  written  to  an  ASCII,  comma-delimited  file  that  can be
imported into many database or spreadsheet programs.  An option is available to
omit  the  catalog  entry's  description  field.   An  example  of  an  ASCII  comma-
delimited item is shown below:

"386CMPTR.CGM","",667,482,"256","CGM","D:\PR2US\CLIPART\
COMPUTER\","DRIVE D","","","","3356","05/22/1991","03:00:00",""
"4SEASONS.PCX","",1080,986,"2","PCX","G:\
PCX\","WORM0001","","","CHRISTMAS  SANTA
CLAUS","92803","08/04/1988","12:00:00",""
"5_25DISK.CGM","",667,482,"256","CGM","D:\PR2US\CLIPART\
COMPUTER\","DRIVE D","","","","1274","05/22/1991","03:00:00",""
"9TO5.PCX","",1064,1137,"2","PCX","G:\PCX\","WORM0001","","","CLIPART
9TO5","58938","08/03/1988","12:00:00",""
"A-MELLEA.TIF","",852,689,"2","TIFF","G:\TIF\","WORM0001","","","FUNGUS
DRAWING","23548","11/21/1991","07:32:13",""



The Fields in each item, separated by commas are, in sequence:
1. File Name.
2. Title.
3. Image width in pixels.
4. Image height.
5. color resolution: 2, 16, 256, >256.
6. Format: GIF89, PCX, TIFF, etc.
7. Primary pathname.
8. Primary volume id.
9. Backup pathname.
10. Backup volume id.
11. File size in bytes.
12. File modification/creation date.
13. File time.
14. Description (optional).

THE END!!!!!!!!!!!


